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Pro Tym Lightning General Ledger 
 to Creative Solutions Accounting 

Conversion Guide 
 
The Utilities / Data Conversion / Pro Tym Import command in Creative Solutions Accounting (CSA) can be 
used to import data files from Pro Tym Lightning General Ledger into the Write-Up Solution bundle of modules 
within CSA. This conversion guide explains the necessary steps to convert your data, to identify the fields that 
will not be converted, and to document exceptions that you may encounter during the conversion process. The 
last section of this document explains the steps you should take to verify that the converted data is correct. 
 
Please review this document in its entirety before actually beginning the conversion process for a client. 
 
PRO TYM THUNDER PAYROLL USERS: This guide has been designed to walk you through the conversion 
of Lightning GL and After the Fact Payroll client data to Creative Solutions Accounting. If you process live 
checkwriting payroll clients using Thunder Payroll, please see the Pro Tym Thunder conversion guide. 

CONVERSION PROGRAM OVERVIEW 
The overall objective of the Pro Tym Lightning GL to CSA conversion utility is to provide a comprehensive 
conversion of your Lightning GL data to CSA. However, due to differences in processing calculations and data 
structures between Lightning GL and CSA, some Lightning GL data cannot be converted. Therefore, you should not 
expect to exactly duplicate results from Lightning GL using the converted data without adding or modifying 
the appropriate data in CSA. The specific items that cannot be converted and conversion exceptions are listed 
in the section of this document entitled “Conversion Notes and Exceptions.”  

Note: Payroll check information is not converted to CSA. It is recommended that you convert your client data at the 
beginning of a new quarter or year as some reports may not calculate correctly if you convert the client data in the 
middle of a quarter. Also, some manipulation of your data in Lightning GL may be required prior to conversion. For 
more information, please refer to the section of this document entitled “Processing Steps Required for Each Client 
Prior to Running the Conversion Program.” 

Things you need to know before performing conversions for a specific company: 

! Client ID in Lightning GL. 
! Client processing period and fiscal year end date. 
! General ledger account mask in Lightning GL. 
! If processing After the Fact Payroll, the payroll period and pay frequency. 

 

Important! Please do not close the year for your Pro Tym clients before converting into CSA if you plan to begin 
processing in CSA for the client’s new year. 
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PROCESSING STEPS REQUIRED FOR EACH CLIENT PRIOR 
TO RUNNING THE CONVERSION PROGRAM 
! We recommend that you review the After the Fact Payroll earnings and deduction codes and their associated 

descriptions for each client prior to running the conversion. An Earnings and Deduction Translation 
screen is provided during the conversion so that you can translate the client’s earnings and deduction codes 
to the allowable CSA pay and deduction codes. The screen will present the code and description as entered in 
After the Fact Payroll. If the description does not adequately identify what the code is used for, you should 
modify the description to specifically identify the purpose of each earnings and deduction code. 

 
! We recommend that you review the general ledger account numbers for each client. CSA does not allow 

alpha characters to be used in general ledger account numbers. If you used alpha characters (A-Z) as your 
account number or department ID in Lightning GL, you will need to renumber your account numbers in 
Lightning GL prior to processing the conversion. 

 
! The conversion process includes only transactions that have been posted to the general ledger. Before you 

begin the conversion of any client, you should verify in Lightning GL that all transactions have been 
properly posted by running the General Ledger Posting option (item 2 on the Main Menu). Make sure that 
the posting process is completed, that you are in balance, and that the transactions have posted without 
errors. If there are unposted transactions you will not be permitted to convert the client. 

INSTALLING THE LIGHTNING GL CONVERSION PROGRAM 
Use the following steps to install the Lightning GL to Creative Solutions Accounting conversion program. 

1. Insert the Creative Solutions Accounting CD into your CD-ROM drive. 
2. Click the Start button on the Windows Taskbar and choose Run. 
3. In the Run dialog, type d:\Protym\Install.exe (where d: represents the CD-ROM drive where the Creative 

Solutions Accounting CD has been inserted).  
4. Follow the prompts as they are displayed on the screen during the installation of the Lightning GL to CSA 

conversion utility. 

CREATING THE IMPORT FILES 
Use the following steps to convert Lightning GL and After the Fact Payroll client data into CSA. You may refer to 
this document for all information regarding this conversion. 

Important! Please be sure not to perform the Year End Close function before attempting to create the Import files 
for CSA if you plan to begin processing in CSA for your client’s new year. If you perform the year end close for your 
client before creating the Import files, you will receive the message Month 01 not closed when you attempt to 
Export to CSA, and the file creation process is stopped. 

1. Start the Lightning GL program by clicking the Lightning GL icon in the Protym folder on the Programs list. 
2. From the main menu, select the File Maintenance option. 
3. From the File Maintenance menu, select the Software Interface option. 
4. From the Software Interface menu, select the Export to Creative Solutions option. 
5. Enter the client ID you wish to convert and press ENTER. For a list of available clients, enter a question 

mark in the client ID field and press Enter. 
a. If the client you are processing has unposted transactions or the period has not been properly closed, 

you will be notified by the system. You will need to correct the error before proceeding. 
b. If you previously ran a conversion and you have to rerun the conversion again, you will be prompted to 

overwrite the existing export files. Choose Y to continue.  
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c. If you receive a Net Change error report while processing the conversion, you may need to perform a 
Restore Net Change from History file. You can access this option by choosing option 8 Utilities from 
the main menu and then selecting option E. Verify/Restore Net Change from History. 

6. If you process After the Fact Payroll for this client, you will now be presented with a Pay Type/Deduction 
translation screen. Use this screen to translate the pay type and/or deduction type to the appropriate CSA 
payroll items. If the pay or deduction type is not listed in the CSA list, you should choose type Other 
Earnings or Other Deductions for the item. Earnings and deduction items such as wages, overtime, FWT, 
FICA, State, and Local are automatically coded to the proper CSA earnings/deduction type codes by the 
conversion program. To change the default codes, follow the steps below: 
a. To change the code for an earnings or deduction item, use the up or down arrow to highlight the item 

and press ENTER. 
b. The Translate to CSI screen will now be presented. Highlight the item that is currently check marked 

and press Enter to remove the checkmark. 
c. Using the up or down arrow, highlight the appropriate code and press ENTER to select the proper CSI 

earnings or deduction code. 
7. Press ESC to complete the conversion. 

 

IMPORTING THE CONVERTED CLIENT DATA INTO CSA 
Use the following steps to convert and import a Lightning GL client into CSA. You may refer to this document for all 
information regarding this conversion. 

1. Start the CSA program by clicking the desktop shortcut icon for Creative Solutions Accounting. 
2. Create a new client in CSA by choosing New Client from the File menu. (For more information on creating 

a new client, choose CSA Help Topics from the Help menu and then; in the Index tab of the Help dialog, 
choose New Client [File menu]. 

 
Note: When adding the client to CSA, you must complete the current period end date, current fiscal year end, 
current payroll end date, and payroll frequency. The current period end date and current fiscal year end date 
should match what is entered in Lightning GL for this client. If you are converting general ledger and payroll 
information, you will also need to select both the General Ledger Solution and Payroll Compliance Solution 
modules when adding the client. Remember that you have the option of clicking on the client 
information fields during the conversion and pasting that information into the CSA fields. 

 
3. From the Utilities menu, choose Data Conversion / Pro Tym Import. 
4. In the first field of the Import dialog, enter the location of the converted Lightning GL data files that you 

wish to import into CSA. This will generally be d:\PTS\DATA (where d: represents the drive letter where 
Lightning GL is installed). The conversion program will write the exported files into the same directory that 
the client data exists in Lightning GL. 
Example: If your Lightning GL data files are on drive F, you would enter F:\PTS\DATA.  

5. In the Client to import field, enter the client ID you want to import. It may be useful to print a list of clients 
from the Lightning GL program before beginning. The Client List report will show the client ID and name. 

6. If you wish to convert the employee earnings totals, mark the Convert Employee Earnings checkbox. If 
you leave this field blank, employees will be converted with no year to date totals for pay and deductions. 

7. Click the Import button. 
8. After the import has been successfully completed, you should make the necessary changes or corrections to 

the converted data as specified in the sections of this document below entitled “Items Transferred during 
Conversion of Lightning GL Data” and “Conversion Notes and Exceptions.” 
 
Note: Continue with steps 9 and 10 if you converted the client’s data at the client’s year end, and you want 
to process the new year in CSA. 
 

9. Verify that your the conversion has worked correctly by checking the converted information, and then you 
can continue with the Year End close function in Pro Tym. 
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10. To begin General Ledger processing for your client’s new year in CSA you must first close to the new 
General Ledger year in CSA. Use these steps to close the General Ledger period to the next year in CSA: 

 
a. From the File menu, choose Select Period to Process. 

b. Click Close to Next Year. If you have closed this year before, and your client has multiple locations, 
skip to step g. If there are no specified locations, skip to step i. 

c. The Period End Dates dialog will appear. Choose the period end dates for the next year. The program 
will automatically default the date based on the client’s properties. To modify the date, highlight the 
part of the date you want to modify and click the small up / down arrow. To view a calendar, click the 
large down arrow. 

d. Click OK to accept the period end dates for next year. 

e. The Budget Options dialog will appear. Choose from the available options how you want to handle 
budgets in the new year. 

f. Click Continue to accept your choice of budget option. 

g. If you have locations set up, the Close the Year dialog will appear. Choose if you want to close the 
client’s locations individually, or if you want to close all accounts by a percentage. 

h. Click Continue to accept your choice. 

i. The Year End Close dialog will appear. Enter the year end income / loss distributions into this dialog. 
You can also close (if you choose to) Asset and Liability accounts into other Asset and Liability 
accounts (for example, Account 120.1 and 120.2 would close into 120). If you chose to close all 
accounts by a percentage, the total income / loss will be distributed as you specify here. If you chose to 
close the client’s locations individually, there will be a dialog to specify the income / loss distribution 
for each location. 

j. Click Continue to accept your entries and complete the year-end closing. 

ITEMS TRANSFERRED DURING CONVERSION OF 
LIGHTNING GL DATA 

The following tables are provided to identify Lightning GL fields that will be converted to Creative Solutions 
Accounting. The tables are organized by Lightning GL and CSA screens and denote the necessary CSA screen 
navigation.  

Lightning GL General Ledger Account Information 
Lightning GL  
Field Name 

CSA Menu Navigation 
CSA Field Name 

Comments and additional information  
 

Account # Setup / Chart of Accounts 
Acct # 

See “Conversion Notes and Exceptions” for more 
information on the conversion of the account 
numbers. 

Description Setup / Chart of Accounts 
Description 

While the description in Lightning GL is 35 
characters long, the description in CSA is 29 
characters long. Only the first 29 characters of the 
Lightning GL description will be converted. 

Account Type Setup / Chart of Accounts 
Type 

The Type field is translated from the Account Type 
field used in Lightning GL. For more information on 
combining accounts, see “Conversion Notes and 
Exceptions” in this document. 

Current Year Balances Setup / Chart of Accounts 
19yy or 20yy Balance 
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Lightning GL  
Field Name 

CSA Menu Navigation 
CSA Field Name 

Comments and additional information  
 

Current Year Budget Setup / Chart of Accounts 
19yy or 20yy Budget Balances 

Lightning GL allowed you to enter in a beginning 
balance for the budget amounts. This amount will not 
be converted into CSA. Only periods 1-13 will be 
converted. 

Prior Year GL 
Balances 

Setup / Chart of Accounts 
19yy or 20yy Balance 

Five prior fiscal year balances will be converted, 
allowing for a 5-year comparative statement in CSA. 

Account Type Setup / Chart of Accounts / Edit / 
Enter Combining Accounts 

Lightning GL allowed you to enter in an account 
type used to group accounts for reporting purposes. 
These groups have been converted as combining 
accounts into CSA for financial statement reporting 
purposes. 

 

Lightning GL General Ledger Transactions  
Lightning GL  
Field Name 

CSA Menu Navigation 
CSA Field Name 

Comments and additional information  

Refer# Tasks / Transaction Entry 
Reference  

 

Date Tasks / Transaction Entry 
Transaction Date 

 

Account Tasks / Transaction Entry 
Account Number 

 

Description Tasks / Transaction Entry 
Description 

 

Amount Tasks / Transaction Entry 
Amount 

 

 

After the Fact Payroll Employee Information 
After the Fact Payroll  
Field Name 

CSA Menu Navigation 
CSA Field Name 

Comments and additional information  

Employee ID Setup / Employees / General tab 
ID 

 

First name Setup / Employees / General tab 
First 

After the Fact Payroll stores the first name and 
middle initial in a single field. The conversion will 
parse the field in the same manner After the Fact 
Payroll parses for W-2s. 

First name Setup / Employees / General tab 
MI  

After the Fact Payroll stores the first name and 
middle initial in a single field. The conversion will 
parse the field in the same manner After the Fact 
Payroll parses for W-2s. 

Last name Setup / Employees / General tab 
Last  

 

Address Setup / Employees / General tab 
Street 

 

City, State Setup / Employees / General tab 
City 

After the Fact Payroll stores the city and state in a 
single field. The conversion will parse the field in the 
same manner After the Fact Payroll parses for W-2s. 

City, State Setup / Employees / General tab 
State 

After the Fact Payroll stores the city and state in a 
single field. The conversion will parse the field in the 
same manner After the Fact Payroll parses for W-2s. 
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After the Fact Payroll  
Field Name 

CSA Menu Navigation 
CSA Field Name 

Comments and additional information  

Zip Setup / Employees / General tab 
Zip 

 

S-S-N/Fed ID Setup / Employees / General tab 
SSN/EIN 

 

Dept# Setup / Employees / General tab 
Department 

The department in After the Fact Payroll is stored as 
a two-character value. This value will be converted 
with the text “Department #” appended to the 
beginning of the value to this field.  

St tax ID Setup / Employees / Tax 
Withholding and Deduction tab 
State W/H Properties button 
State 

 

 

After the Fact Payroll Employee Earnings and Deductions Balances 
After the Fact Payroll  
Field Name 

CSA Menu Navigation 
CSA Field Name 

Comments and additional information  

Y-T-D Earnings 
Reg. 

Setup / Employees / Earnings tab 
Wages 

If you coded an employee as hourly, the REG code 
will be converted as Wages in CSA. If the employee 
was coded as Salaried, the REG code will be 
converted as Salary in CSA. 

Y-T-D Earnings 
O/T. 

Setup / Employees / Earnings tab 
Overtime 

 

Y-T-D  
Other (user defined)  

Setup / Employees / Earnings tab 
Commissions 

Any After the Fact Payroll code (User defined) that 
was translated to Commissions in the Earning and 
Deductions Translation screen will be converted to 
this field. 

Y-T-D  
Other (user defined) 

Setup / Employees / Earnings tab 
Bonus 

Any After the Fact Payroll code (User defined) that 
was translated to Bonus in the Earning and 
Deductions Translation screen will be converted to 
this field. 

Y-T-D Earnings 
Sick 

Setup / Employees / Earnings tab 
Sick Pay 

 

Y-T-D Earnings 
Vac. and Hol. 

Setup / Employees / Earnings tab 
Vacation 

Any amount in the After the Fact Payroll fields Vac. 
and Hol. will be added together and converted to this 
field.  

Y-T-D Miscellaneous 
Tips 

Setup / Employees / Earnings tab 
Reported Tips 

 

Y-T-D Miscellaneous 
E.I. Cred. 

Setup / Employees / Earnings tab 
EIC Advance 

 

Y-T-D  
Other (user defined) 
Per. 

Setup / Employees / Earnings tab 
Other Wages 

Any After the Fact Payroll code (User defined) that 
was translated to Other Earnings in the Earnings and 
Deductions Translation screen will be converted to 
this field. In addition, amounts in the Per. field will 
be converted to this field.  

Y-T-D W/H 
FICA 

Setup / Employees / Tax 
Withholdings and Deductions tab 
FICA-SS 

Amounts in the After the Fact Payroll code FICA 
field contain both the FICA-SS and FICA-Med 
amounts. The conversion will divide this amount in 
the same manner After the Fact Payroll does for  
W-2s. 
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After the Fact Payroll  
Field Name 

CSA Menu Navigation 
CSA Field Name 

Comments and additional information  

Y-T-D Earnings 
Reg. 

Setup / Employees / Earnings tab 
Wages 

If you coded an employee as hourly, the REG code 
will be converted as Wages in CSA. If the employee 
was coded as Salaried, the REG code will be 
converted as Salary in CSA. 

Y-T-D W/H 
FICA 

Setup / Employees / Tax 
Withholdings and Deductions tab 
FICA-Med 

Amounts in the After the Fact Payroll code FICA 
field contain both the FICA-SS and FICA-Med 
amounts. The conversion will divide this amount in 
the same manner After the Fact Payroll does for  
W-2s. 

Y-T-D W/H 
FWT 

Setup / Employees / Tax 
Withholdings and Deductions tab 
Federal W/H 

 

Y-T-D W/H 
State 

Setup / Employees / Tax 
Withholdings and Deductions tab 
State W/H 

 

Y-T-D W/H 
City and Local 

Setup / Employees / Tax 
Withholdings and Deductions tab 
Local W/H 

Amounts in the After the Fact Payroll code fields 
City and Local (SID) will be combined and 
converted to this field. 

Y-T-D  
Other (user defined) 

Setup / Employees / Tax 
Withholdings and Deductions tab 
401K % of Gross 

Any After the Fact Payroll code (User defined) that 
was translated to 401(k) in the Earnings and 
Deductions Translation screen will be converted to 
this field. 

Y-T-D  
Other (user defined) 

Setup / Employees / Tax 
Withholdings and Deductions tab 
Cafe % of Gross 

Any After the Fact Payroll code (User defined) that 
was translated to Cafeteria in the Earnings and 
Deductions Translation screen will be converted to 
this field. 

Y-T-D  
Other (user defined) 

Setup / Employees / Tax 
Withholdings and Deductions tab 
Loan Repayment 

Any After the Fact Payroll code (User defined) that 
was translated to Loan Repayments in the Earnings 
and Deductions Translation screen will be converted 
to this field. 

Y-T-D  
Other (user defined) 

Setup / Employees / Tax 
Withholdings and Deductions tab 
Medical Insurance 

Any After the Fact Payroll code (User defined) that 
was translated to Medical Insurance in the Earnings 
and Deductions Translation screen will be converted 
to this field. 

Y-T-D  
Other (user defined) 

Setup / Employees / Tax 
Withholdings and Deductions tab 
Life Insurance 

Any After the Fact Payroll code (User defined) that 
was translated to Life Insurance in the Earnings and 
Deductions Translation screen will be converted to 
this field. 

Y-T-D Miscellaneous  
Meals 

Setup / Employees 
Tax Withholdings and Deductions 
tab 
Meals/Lodging 

 

Y-T-D  
Other (user defined) 

Setup / Employees / Tax 
Withholdings and Deductions tab 
Uniforms 

Any After the Fact Payroll code (User defined) that 
was translated to Uniforms in the Earnings and 
Deductions Translation screen will be converted to 
this field. 

Y-T-D  
Other (user defined) 

Setup / Employees / Tax 
Withholdings and Deductions tab 
Union Dues 

Any After the Fact Payroll code (User defined) that 
was translated to Union Dues in the Earnings and 
Deductions Translation screen will be converted to 
this field. 
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After the Fact Payroll  
Field Name 

CSA Menu Navigation 
CSA Field Name 

Comments and additional information  

Y-T-D Earnings 
Reg. 

Setup / Employees / Earnings tab 
Wages 

If you coded an employee as hourly, the REG code 
will be converted as Wages in CSA. If the employee 
was coded as Salaried, the REG code will be 
converted as Salary in CSA. 

Y-T-D  
Other (user defined) 

Setup / Employees / Direct 
Deposit tab 
Amount 

Any After the Fact Payroll code (User defined) that 
was translated to Direct Deposits in the Earnings and 
Deductions Translation screen will be converted to 
this field. 

Y-T-D  
Other (user defined) 

Setup / Employees / Tax 
Withholdings and Deductions tab 
Other Deductions 

Any After the Fact Payroll code (User defined) that 
was translated to Other Deductions in the Earnings 
and Deductions Translation screen will be converted 
to this field. 

 

After the Fact Payroll Vendor Information 
After the Fact Payroll 
Field Name 

CSA Menu Navigation 
CSA Field Name 

Comments and additional information  

Recipient ID Setup / Vendors / General tab 
Vendor ID 

 

First name/Last name 
Company name 

Setup / Vendors / General Tab 
Name 

The After the Fact Payroll field’s First name and 
Last name will be appended together and converted 
to this field for individuals. The After the Fact 
Payroll field Company name will be converted to 
this field for company vendors. 

Address 
Addl co name 

Setup / Vendors / General tab 
Street#1 

If the After the Fact Payroll field Addl co name, is 
used for company vendors, that information will be 
converted in the Street#1 field. If blank, Address will 
be converted into the Street#1 field in CSA. 

Address 
 

Setup / Vendors / General tab 
Street#2 

If the After the Fact Payroll field Addl co name, is 
used for company vendors, the information in the 
Address field for those vendors will be converted 
into the Street#2 field in CSA. 

City, State Setup / Vendors / General tab 
City 

After the Fact Payroll allowed you to enter the City 
and State in 1 field. CSA has separate fields for City 
and State. The conversion will parse the City/State 
field into 2 fields the same way it parses for W-2s. 

City, State Setup / Vendors / General tab 
State 

After the Fact Payroll allowed you to enter the City 
and State in 1 field. CSA has separate fields for City 
and State. The conversion will parse the City/State 
field into 2 fields the same way it parses for W-2s. 

Zip Code Setup / Vendors / General tab 
Zip 

 

S-S-N/Fed ID Setup / Vendors / General tab 
EIN 

 

1099 Type YTD Setup / Vendors / Distributions tab 
Year to date checks 

This amount represents the year-to-date amounts for 
the vendor. It does not break the amounts into 1099 
type. If there are multiple 1099 type payments, you 
will need to manually break this information apart in 
CSA after the conversion. 
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ITEMS NOT TRANSFERRED DURING CONVERSION OF 
LIGHTNING GL DATA 
Although most Lightning GL data is converted, some data cannot be converted due to differences in program features 
and data structures between Lightning GL and CSA. If an item below is denoted with an asterisk (*), it is further 
explained in the “Conversion Notes and Exceptions” section of this document. The following items, which cannot be 
converted, are organized by Lightning GL screen.  

General Client Information 
Client ID, name, address, city, state, zip code, telephone, federal/state/suta ID, rates and fiscal year end month cannot 
be converted. All of this information should be set up while adding the client to CSA, or you can add it later in the 
File / Client Properties dialog. 

Journal Source Information 
The journal setup information and source definitions are not converted.  

Employee Information 
Active/Inactive mark box, pay period, marital status, Calc reg check, manager status, ethnic code, Misc ID code and 
description, exemption codes, date of birth/hire/termination, review and raise information, pay/OT rate, standard 
hours and W2 status box fields cannot be converted into CSA. Additionally, all client setup information in After the 
Fact Payroll (ATF version of Thunder Payroll) will not be converted. 

Payroll Transactions / Prior Earnings Balances 
Check number, transaction date and amounts for the current year as well as prior years’ payroll transactions cannot be 
converted.  
 
Additionally, earnings and deduction balances for the current period and current quarter cannot be converted. Only 
the year to date earnings and deductions balances can be converted to enable you to process W-2s and other year end 
payroll reports. 

Vendor Information 
1099, Inactive/Active, state tax ID and corrected return checkbox cannot be converted. Additionally, After the Fact 
Payroll allowed you to setup a template vendor using the ID ZZZZZ. If this vendor ID is found, it will not be 
converted to CSA. 

Tax Line Grouping Codes 
Because Lightning GL allows you to enter tax line grouping codes for a number of different tax products, it is 
impossible to determine that the tax line grouping code entered is for UltraTax. The tax codes will therefore need to 
be entered manually in the Chart of Accounts dialog in CSA after the conversion has been completed. 

Other Information 
Program preferences, cash flow transactions (memo transactions), loan amortization information, general ledger and 
financial statement reporting options such as whole dollar rounding, verbiage file and consolidated client information 
cannot be converted. 

CONVERSION NOTES AND EXCEPTIONS 
The following section details all known conversion exceptions between Lightning GL data and the converted CSA 
data. Conversion exceptions may include differences in field lengths between Lightning GL and CSA, required 
parsing of information from one field in Lightning GL to multiple fields in CSA, and manipulation of Lightning GL 
data to conform with CSA requirements, and so forth. 
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Chart of Accounts Mask 
The CSA Chart of Account Mask is a template that defines the structure of the client's general ledger accounts. In 
Lightning GL, the structure of an account number is fixed, except for splitting the number to the right of the dash into 
departments. The conversion of general ledger accounts from Lightning GL to CSA is relatively straightforward. 
However, there are a few minor differences that need to be accounted for prior to converting your clients. 
• The conversion program does not set up the CSA client’s Chart of Accounts Mask; you must do this when 

creating the new client. Therefore, prior to importing the converted file, you should specify the Account Mask (in 
the File / New Client dialog) when adding each new client. 

• CSA requires that department numbers be located to the left of the core account number (if present). Lightning 
GL requires that the department number be located to the right of the core account number. The Account Mask 
you should use depends upon how Departments are set up in Lightning GL. Examples of how departments are 
converted are as follows: 
 
Type of Account  Pro Tym  CSA Account Mask  
No Departments  500  CCC or 500 
1-9 Departments  500.1  DCCC or 1500 
10-99 Departments  500.99  DDCCC or 99500 
 

• CSA accepts only numeric values and a single decimal point when entering account numbers. If you used alpha 
characters to identify different departments, you will need to renumber the departments in Lightning GL before 
converting this client. 

Account Types 
CSA uses account types to determine the proper sign (debit or credit) for each general ledger account. The conversion 
has translated the TYPE field in Lightning GL to the Account Type field in CSA. The following table displays the 
translation that occurs during the conversion: 
 

Pro Tym TYPE CSA Account Type 
CA A 
FA A 
OA A 
CL L 
LL L 
C L 
NI Not Converted (see below) 
I R 
CS E 
E E 
R R 
O E 
X E 

Net Income Account 
CSA does not support the use of a Net Income Account which is allowed in Lightning GL. If you had a net income 
account setup in lightning GL, it has not been converted. Net Income is a calculated number in CSA and is calculated 
when reports are executed. 

Future-Period Transactions 
CSA does not allow you to convert future-period transactions, while Lightning GL did allow this function. Any 
future-period transactions entered in Lightning GL — that is, any transactions entered with a reference date later than 
the current period end date — will not be imported in to CSA.  
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Consolidated Clients 
The conversion program is unable to distinguish a consolidated client from a regular GL client. When you add a 
consolidated client into CSA, you must mark the Consolidation Client checkbox on the Client Properties Screen / 
General Information tab. 

Terminated Employees 
If an employee is marked as inactive or terminated, the conversion will still convert the employee if they have current 
wages or deductions. If no amounts exist for the inactive employee, they will not be converted. 

Multi-State Payroll Clients 
If you process any clients with state withheld amounts for multiple states, the amounts withheld for each state will be 
combined into a single state withholding field during the translation of the pay codes. This is due to a limitation in the 
conversion and does not reflect the processing capabilities of CSA. (CSA does allow you to process clients with any 
number of different state and local withholding amounts.) After you import the client data, we suggest that you create 
a withholding type in CSA for each state and break the amounts out of the state withheld field after the conversion has 
completed. 

Allocated Tips 
After the Fact Payroll allowed you to specify Allocated Tips as a separate withholding item during payroll data entry. 
CSA will also allow you to set up a separate withholding amount for Allocated Tips; however the import is not able to 
distinguish the Allocated Tips amount and to create the withholding item. The conversion program has not converted 
the Allocated Tips amount as this is generally entered at the end of year for W-2 purposes. We recommend adding an 
Allocated Tips item after the conversion has been completed. 

SDI Withheld  
After the Fact Payroll allowed you to specify SDI as a separate withholding item during payroll data entry. CSA will 
also allow you to set up a separate withholding amount for SDI; however the import is not able to distinguish the SDI 
amount and to create the withholding item. The SDI has been converted into the Local Withheld category in CSA. 
You can then reclassify the Local Withheld amount as SDI or reduce the Local Withheld by the amount of the SDI 
when you create a new deduction classification. 

VERIFYING YOUR CONVERTED DATA 
Although the conversion utility has been designed to convert your data as accurately as possible, there may be some 
instances when not all data converts correctly due to Lightning GL data corruption and other anomalies within the 
Lightning GL data. You should follow the steps below to verify that your Lightning GL data has been converted correctly. 

1. In Lightning GL, print the General Ledger report. 
2. Start Creative Solutions Accounting and open the new client that was created. From the File menu, choose Open 

Client. In the Open Client dialog, double-click the appropriate Client ID. 
3. In CSA, print the General Ledger and Trial Balance reports. 
4. Compare the two sets of reports. If the information contained in the Lightning GL reports does not match the 

CSA reports, you will need to determine which transaction(s) are invalid or missing and manually enter those 
transactions into CSA. Other reports are available in both systems if you cannot determine the discrepancy using 
the above-listed reports.  

5. In Lightning GL, print the Earnings Report and Summary Report. 
6. In CSA, print the Payroll Tax Summary report. 
7. Compare the amounts on the Lightning GL and CSA payroll reports and note any discrepancies. You may make 

manual changes to any payroll amount in the CSA program. 
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If problems are encountered 
If problems are encountered during the conversion of your client data from Lightning GL to Creative Solutions 
Accounting and you are unable to reconcile the data using the various reports and tools in CSA, contact CSI Product 
Support.  

SUPPORT 
Web Site 
If you have questions or need assistance, you can visit our Web site at www.CreativeSolutions.com 24 hours a day 
for the latest information on current issues and processing tips. To take advantage of this convenient means of 
accessing information, choose CSI on the Web from the CSA Help menu, and then click Product Support and 
Service.  
 
Product Support 
To speak with a Product Support Representative, please call the CSI HelpLine at 800-968-0600, press 3 for 
accounting support, and then listen to the options available before pressing the number for Creative Solutions 
Accounting. Normal weekday support is from 9:00 AM to 8:00 PM Eastern Time.  
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